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1 Main Index

  Crocus 4 Help Index

Getting Started

Crocus Remote

Commands
File menu
Edit menu
Image menu
View menu
Window menu
Video menu
Help menu

1.1 Title Bar

Title Bar

The title bar is located along the top of a window.  It contains the name of the application and
drawing.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their
title bars.

A title bar may contain the following elements:
Application Control-menu button
Drawing Control-menu button
Maximize button
Minimize button
Name of the application
Name of the drawing
Restore button

1.2 Scroll Bars

 Scroll bars

Displayed at the right and bottom edges of the drawing window.  The scroll boxes inside the scroll
bars indicate your vertical and horizontal location in the drawing.  You can use the mouse to scroll to
other parts of the drawing.
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1.3 Size

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow
keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to

the border you want to move.  
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.

1.4 Move

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog
box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7

1.5 Minimize

Minimize command (application Control menu)

Use this command to reduce the Crocus window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9
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1.6 Maximize

Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a drawing window.

1.7 Next Window

Next Window command (drawing Control menu)

Use this command to switch to the next open drawing window.  Crocus determines which window is
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6

1.8 Previous Window

Previous Window command (drawing Control menu)

Use this command to switch to the previous open drawing window.  Crocus determines which
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

1.9 Close

Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a drawing window

ALT+F4 closes the application
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1.10 Restore

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the
Maximize or Minimize command.

1.11 Switch to

Switch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close
an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.  This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.  This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.

2 Crocus Remote

  Crocus Remote

The Crocus remote provides access to many of the most-used commands in Crocus.  Info about
each button can be obtained by using the '?' box located near the close box in the top right-hand
corner.
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2.1 New button

   New button

Use this button to open a new drawing window in Crocus.  This is useful to view minor changes to a
drawing, or create a new drawing while keeping parameters for another drawing in view.

2.2 Abort button

   Abort button

Use this command to stop drawing.  Clicking inside a window's drawing area or close box (or the
program close box) will also stop the drawing.  Once a plot has started Crocus continues to draw
the image for that window regardless of which drawing window has the input focus, until done or
aborted.  You can open and close other drawing windows without affecting the current drawing, but
only one drawing is active at any time.  If you start a drawing while another draw window is
active, using the Apply button in the Figures window, it will be necessary to activate the
drawing's window before the drawing can proceed.  This is not necessary if you use the
Pilot or Remote or Toolbar to start a drawing.

2.3 Size button

    Size button

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The size of an image can range in standard 4/3 and 1/1
aspects from 160X120 to 3564X2784 or you can choose a custom XY size.  The custom setting
allows for any size/aspect that system memory will permit.  

2.4 Pilot button

    Pilot button

Opens the Pilot window.  

2.5 View button

    View button

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by the inclusion of the

title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the left-
mouse button.



Crocus 4 Application Help6

© 2003 -- 2010 ... Mystic Fractal

2.6 Help button

    Help button

Use this button to open the help index for Crocus.  

2.7 Figure button

    Figure button

Use this button to draw or redraw the figure for the current fractal variables.  Clicking inside the
draw window with the left-mouse button stops all plotting.

2.8 Scene button

    Scene button

Use this button to draw or redraw the scene for the current fractal variables.  Clicking inside the
draw window with the left-mouse button stops all plotting.

2.9 Figures button

    Figures button

Use this button to edit parameters for foreground figures and the background. 

2.10 Light button

    Light button

Edit lighting variables and position light source 

2.11 Save button

   Save button

Use this button to save and name the active drawing.  Crocus displays the Save As dialog box so
you can name your drawing.  

To save a drawing with its existing name and directory, use the File/Save command.

2.12 Load button

   Load button

Use this button to open an existing data/image file in a new window.  You can open multiple image
files at once.  Use the Window menu to switch among the multiple open images. 
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2.13 Bmp radio button

    BMP radio button

Use this button to select the BMP format when loading and saving fractals.  This is the default
Windows bitmap format, readable by most Windows programs that use image files.  This is also the
fastest method of loading and saving fractals, but requires more disk space, since no compression is
used. Windows keeps track of the last six BMP files saved or loaded (displayed in the Files menu.) 

2.14 Png radio button

   PNG radio button

Use this button to select the PMG format when loading and saving fractals.  This format uses
medium compression without loss of image quality.

2.15 Jpg radio button

   JPG radio button

Use this button to select the JPEG format when loading and saving fractals.  This format uses
moderate compression but with some loss of image quality.  This is preferable for posting to the net,
since most browsers can display jpeg files.

2.16 ||||| button

    ||||| button

Through a series of windows, this allows you to name and open an avi animation stream and choose
a compression method.  After choosing the frame rate (0-60) and using the file requester to name
the file, you are given a choice of compression methods.  You can also choose no compression for
optimum view quality.  (All compression methods degrade the original images, some more than
others.)  The first key frame in the stream is then drawn and written to the file.

Note: after the stream is opened, the size of the fractal that can be drawn is fixed at the size of the
frame.  No changes can be made to the size until the stream is closed.

2.17 > button

    > button

With this option, frames are written to a stream based on the difference between the current key
frame and the previous key frame.  The first key frame is written when you open a stream.  The next
key frame is created each time you use this option.  In between you can zoom or change Fvr
variables as much as necessary.  The stream is only written to when this option is used.  The last key
frame is automatically saved after the 'tween' series is written.  The number of frames may range
from 1-1500 frames between keys.  With a frame number of 1 only the key frames are written.  This
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allows animation to be created that incorporates all scaleable variables in Crocus.

Use the Cancel button to exit this dialog without initializing a new series of frames.

Check the Log Scaling box if you want the frames to be written with logarithmic space between
frames, else linear space is used.  Useful when zooming, where frames would otherwise be packed
together at the end of the frame series.

2.18 [] button

    [ ] button

Closes any open avi stream file.  You need to do this before viewing the file or creating a new avi
file.  The stream is also closed when you exit Crocus. 

2.19 V button

    V button

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a different
compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files. 

3 File Menu

  File menu commands

The File menu offers the following commands:

New Creates a new drawing.
Open    Opens an existing drawing.
Close    Closes an opened drawing.
Save Saves an opened drawing using the same file name.
Save As    Saves an opened drawing to a specified file name.
Save  Parameters    Save parameters for drawing.
Load Parameters    Load parameters for drawing.
Open [JPG]    Load jpeg.
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Save AS [JPG]    Save in jpeg format.
Open [PNG]    Load png.
Save As [PNG]      Save in png format.
Export Options 

Save Model[OBJ]     Save model for current figure.
Save Figure [OBJ]    Save Lsystem or Fractal to Wavefront object file.
Save Figure [STL]    Save Lsystem or Fractal to STL solid file.
Save Figure POV]    Save Lsystem or Fractal as POVray triangle mesh.
Mesh Setup     Edit/View parameters for exporting meshes.
Save Figure [DXF]    Save Lsystem or Fractal to AutoCad Dxf file.

Exit      Exits Crocus.

3.1 New command

   New command (File menu)

Use this command to create a new drawing window in Crocus.  The image and data for the opening
picture are used to create the new window.

You can open an existing data/image file with the Open command.

Shortcuts
Keys: CTRL+N

3.2 Open command

   Open command (File menu)

Use this command to open an existing data/image file in a new window.  You can open multiple
image files at once.  Use the Window menu to switch among the multiple open images.  See 
Window 1, 2, ... command.

You can create new images with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O

3.2.1 File Open dialog box

File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.  This box lists files with the extension you select in
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the List Files of Type box. 
List Files of Type

Select the type of file you want to open:
Drives

Select the drive in which Crocus stores the file that you want to open. 
Directories

Select the directory in which Crocus stores the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 

3.3 Close command

   Close command (File menu)

Use this command to close the window containing the active image.  If you close a window without
saving, you lose all changes made since the last time you saved it.

You can also close a drawing by using the Close icon on the drawing window, as shown below:

3.4 Save command

   Save command (File menu)

Use this command to save the active drawing to its current name and directory.  When you save a
drawing for the first time, Crocus displays the Save As dialog box so you can name your drawing.
 If you want to change the name and directory of an existing drawing before you save it, choose the 
Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S

3.5 Save As command

   Save As command (File menu)

Use this command to save and name the active drawing.  Crocus displays the Save As dialog box
so you can name your drawing.  

To save a drawing with its existing name and directory, use the Save command.
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3.5.1 File Save As dialog box

File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a drawing with a different name.  A filename can contain up to eight
characters and an extension of up to three characters.  Crocus adds the extension you specify in
the Save File As Type box.

Drives
Select the drive in which you want to store the drawing.

Directories
Select the directory in which you want to store the drawing.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

3.6 Load Parameters command

   Load Parameters command (File menu)

Use this command to load a data file[.cs].  The data file contains all variables to recreate an image
created previously with Crocus.

3.7 Save Parameters command

   Save Parameters command (File menu)

Use this command to save all data elements for the current image in a data file[.cs].

3.8 Open[JPG] command

   Open [JPEG] command (File menu)

Use this command to load parameters and a bitmap file that were saved in jpeg format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images loaded in
JPG format.  This option uses the jpeg library written by the Independent JPEG Group.

3.9 Save As [JPG] command

   Save As [JPEG] command (File menu)

Use this command to save the parameters and active bitmap in jpeg format.  There is an option in
the file-type box to save only the bitmap too.  This replaces the Save and Save As command for
those who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images
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saved in JPEG format.  This option uses the jpeg library written by the Independent JPEG Group.

3.10 Open[PNG] command

   Open [PNG] command (File menu)

Use this command to load parameters and a bitmap file that was saved in png format.  There is an
option in the file-type box to load only the bitmap too.  This replaces the Open command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images loaded in
PNG format.

3.11 Save As [PNG] command

   Save As [PNG] command (File menu)

Use this command to save the parameters and active bitmap in png format.  There is an option in the
file-type box to save only the bitmap too.  This replaces the Save and Save As command for those
who need a smaller sized bitmap file.  Note: the last files list doesn't keep track of images saved in
PNG format.

3.12 Save x64

Save data in Crocus x64 compatible format.  This allows you to transfer old cs data files to a file format
that can be loaded by Crocus x64, the 64 bit version of Crocus.

3.13 Export options

3.13.1 Save Model[OBJ] command

   Save Model [OBJ] command (File menu)

Use this command to save the model vertices and vertex normals of the current figure in a Wavefront
object file.  The model vertices (Wavefront Object) must have been previously loaded via the Edit/
Figures window.  Vertex normals are calculated automatically for every model loaded into Crocus. 
This command acts as an export function for programs (such as Amorphium 1.0) that require vertex
normals in a Wavefront object file to import these files correctly. 

3.13.2 Save Figure [OBJ] command

   Save Figure [OBJ] command (File menu)

When the active figure Type is Lsystem or Fractal, then this command is enabled and may be
selected.  After naming the object file through a file requester, the current figure is redrawn and any
quadrilateral or triangle generated by the cylinder Form or sphere Form will be written to a
Wavefront obj file.  Other forms are ignored.  This is useful to export an lsystem or fractal for use in
Bryce or another program that supports the Wavefront format.  Caveats:  this is capable of
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generating very large files.  The way to reduce file size is to reduce cylinder facets, with the Major
Sections variable.  This should be set at 10 or lower for more complex lsystems or fractals.  Use the
smoothing option in Bryce to round off cylinder shapes in the imported object, if possible.

Related topic: Edit/Figures.

3.13.3 Save Figure [STL] command

  Save Figure [STL] command

When the active figure Type is Lsystem or Fractal, then this command is enabled and may be
selected.  After naming the object file through a file requester, the current figure is redrawn and any
quadrilateral or triangle generated by the cylinder Form or sphere Form will be written to a STL
solid file.  Other forms are ignored.  This is useful to export an lsystem or fractal for use with 3D
printers or other machinery that supports the stl format.  Caveats:  this is capable of generating very
large files.  The way to reduce file size is to reduce cylinder facets, with the Major Sections variable.
This should be set at 10 or lower for more complex lsystems or fractals.

Related topic: Edit/Figures.

3.13.4 Save Figure [POV] command

   Save Figure [POV] command (File menu)

When the active figure Type is Lsystem or Fractal, then this command is enabled and may be
selected.  After naming the object file through a file requester, the current figure is redrawn and any
quadrilateral or triangle generated by the cylinder Form or sphere Form will be written to a POV
triangle object file.  The triangle mesh is included in a sample scene that is POV-ready for trial
purposes.  Other forms are ignored.  This is useful to export an lsystem or fractal for use in Bryce or
another program that supports the Wavefront format.  Caveats:  this is capable of generating very
large files.  The way to reduce file size is to reduce cylinder facets, with the Major Sections variable.
This should be set at 10 or lower for more complex lsystems or fractals.  Use the smoothing option
in Bryce to round off cylinder shapes in the imported object, if possible.

Related topic: Edit/Figures.

3.13.5 Mesh Setup command

   Mesh Setup command (File menu)

Here you edit or view the parameters for simplifying meshes when outputting in Wavefront [obj] or
POV format.  Max input faces and max input vertices determine how much memory is set aside as
buffers for processing the meshes.  Increase or decrease from the default values as the size of the
mesh warrants, or as system memory permits.  The "min radius" variable controls how small
individual spheres in a mesh may be.  Spheres smaller than the minimum radius are omitted from the
exported mesh.  Fractals and lsystems can contain a large amount of spheres when the sphere
primitive is used and all of these increase the size of the mesh proportionately, even the ones that
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may not be visible.  The weld factor controls how close adjacent triangle vertices of a mesh may be
before they are merged into one vertex.  This effectively flattens adjacent triangles or "collapses"
them and reduces mesh size.  Use a small enough weld factor that produces an evenly simplified
mesh without destroying the integrity of the smallest elements of the mesh.  Use the smoothing
routine in Bryce to restore the mesh to optimum curvature.  POV triangle meshes are further
processed into "smooth_triangles" before exporting into the final mesh file.

3.13.6 Save Figure [DXF] command

   Save Figure [DXF] command (File menu)

When the active figure Type is Lsystem or Fractal, then this command is enabled and may be
selected.  After naming the object file through a file requester, the current figure is redrawn and any
quadrilateral or triangle generated by the cylinder Form or sphere Form will be written to an
AutoCad DXF file.  Other forms are ignored.  This is useful to export an lsystem or fractal for use in
Bryce or another program that supports the Wavefront format.  Caveats:  this is capable of
generating very large files.  The way to reduce file size is to reduce cylinder facets, with the Major
Sections variable.  This should be set at 10 or lower for more complex lsystems or fractals.  Use the
smoothing option in Bryce to round off cylinder shapes in the imported object, if possible.

Related topic: Edit/Figures.

3.14 1, 2, 3, 4 command

   1, 2, 3, 4, 5, 6 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last six drawings
you closed.  Choose the number that corresponds with the drawing you want to open.

3.15 Exit command

  Exit command (File menu)

Use this command to end your Crocus session.  You can also use the Close command on the
application Control menu.  Note: if you choose to exit while plotting, the program does not
terminate, but stops the plotting so the program can be safely exited.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4
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4 Edit Menu

  Edit menu commands

The Edit menu offers the following commands:

Size Sets the image size.
Figures    Edit figures list.
Texture->    Select figure texture and mapping.
Lighting    Edit lighting parameters.
Preferences  View/Edit Default Directories

4.1 Size

    Size command (Edit Menu)

This allows you to set the drawing area for a picture, independent of the Windows screen size.  It
also shows which size is currently in use.  The aspect for the drawing is based on the ratio of X
(horizontal width) to Y (vertical height.)  The custom setting allows for any size/aspect that system
memory will permit.  The minimum size for an image is 40X30.

4.2 Figures

    Figures command (Edit Menu)

Use this window to edit the current figure list and parameters.  The window consists of two major
sections, the first dealing with editing the figure list and the second with figure parameters.  The figure
list contains a number of types, selected through the Type list, each having a step specifier.  There
are seven parametric types and five wall types.  The parametric types are defined in Figure Types.
The wall types are provided to set a backdrop for the scene or as flat objects like wall hangings.  

With the Lsystem, type 12, you can use any Lparser-compatible .ls file.  Use the Choose LS button
to choose from one of the .ls files supplied with this program, or any you might find on the net or
generated by programs like Fractal Zplot.  With the Fractal, type 13, you can use any fractal file
created by Fractal Lab.  Use the Fractal Lab button to load any fractal data file [frl] that is supplied
with this program or any you might create with Fractal Lab. With the Kleinian set, type 14, you can
use any data file [dfs] created by Swirlique. Use the Swirlique button to load any figure designed
with Swirlique.  As with texture files, only the file's name and file's pathname are saved for .
ls, .dfs or fractal files in Crocus data files.  If you move one of these files later Crocus may
not be able to find it unless it resides in the default startup directory of Crocus or the
default save/load directories specified in the Preferences window.  

There is also a Palette button for editing the colors of the background and current figure, if no bitmap
texture is selected from the Edit/Texture menu.  Use the Sample button for an example of each figure
type.  The current figure is replaced with the parameters of the sample.  Some of the Figure and
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Form parameters like Figure/Pack, Figure/Spacial Distance and Form/Spacing have different uses
for the Type 13 and/or Type 14 figure types.  If you're not sure how these work, click on the
Sample button to display the default settings for each Type.

Use the Add button to add figures to the figure list.  Use the Delete button to remove figures from
the list.  Type changes to the figure list are made automatically when a different figure is selected
from the figure list, or when the edit window is closed with the Okay button.  Use the Palette button
to edit the color indexes for the selected figure.  Note: if you close the window without using the
Apply button, the most recent changes for the selected figure may be discarded.  Only the most
recent changes are affected, and only if you haven't switched figures through the figure list since the
changes were made.  Closing the window this way doesn't work like a Cancel button.  Once you
create a figure list, it stays in memory until you close the draw window, exit Crocus or delete all
figures in it.  Changes to the figure list become effective (and are not discarded) when you use the
Apply button or switch to another figure.

The other major section of this window is used to edit figure parameters.  This section consists of
two subdivisions, the figure parameters and form parameters.

Figure Parameters
These edit boxes/options relate to the overall shape and characteristics of the figure:
Pack -- determines the density of the forms in a figure.  If Pack is one, then all forms are drawn in
auto step mode or when the steps are more than one.  When Pack is more than one then forms are
skipped for the value of Pack.  For instance, when Pack is ten then ten forms are skipped before
another form is drawn.  Use a pack factor of one when there is only one form involved, i.e. steps is
one.  This variable is overridden somewhat with the Spacing variable in the forms section.  Note: for
lsystems, which are always drawn as a single object regardless of the step mode, the Pack variable
is used to control smoothing/spacing.  When the basic Form is cylinder and the Extended box is
checked, this controls how tube width is calculated from one section of the lsystem to the next.  A
value of one forces the tube width to converge or diverge from the previous width to the current
width in one step.  Values greater than one allow the previous width to be closer to the current width
when drawing the current section, which may look more natural in some cases.  For other forms,
such as sphere and torus, the pack variable controls how many forms are generated between
lsystem sections, so the sections are more connected.  This increases draw time proportionately. 
Note: for Type 14, Kleinian set, the Pack variable is a drop-off factor, where a value higher than
zero controls the width of succesive segments.  The formula used is width=(set_width*.45)-
(set_width*.03)*segment;

Delta -- an angle or factor that determines the overall shape of the figure, if it is one of the parametric
types.  Look at the definition of the parametric typeFigure Types for more info.  The Sample button
can give a close approximation to what angles are needed for each parametric type, though many
other configurations are possible.  This is especially true for the lissajous type.

Omega -- an angle or factor that determines the overall shape of the figure, if it is one of the
parametric types. Look at the definition of the parametric typeFigure Types for more info.  The
Sample button can give a close approximation to what angles are needed for each parametric type,
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though many other configurations are possible.  This is especially true for the lissajous type.

Spiral Distance -- the expansion factor for a spiral type.  Determines how far apart spirals are in the
spiral figure.  Unused by any other type.

Spiral Growth -- the growth factor for a spiral type.  Determines how fast a spiral type increases in
width as it grows.  Unused by any other type.

Shininess -- determines how much light a figure reflects.  Ranges from 0 to 128, with lower values
increasing reflectiveness.  More reflectiveness doesn't necessarily equate to more material shininess. 
A good value to start with is 20.

Reflect -- the figure's reflective property, as in its ability to be reflected or reflect.  A wall reflects,
while other figures are reflected in them (No attempt is made to calculate reflections that figures may
reflect in other non-wall figures.).  In order to draw reflections in Crocus, the reflect factor must be
non-zero for both the wall that has reflecting properties, and the figure to be reflected.  The reflect
factor ranges from 0-1.0, with 1.0 being an exact reflection.  Values under 1.0 produce reflections
that are blended with the wall's texture/colors.

Shade -- the ability of a figure to cast a shadow or a wall to be shadowed (No attempt is made to
calculate shadows that figures may produce on other non-wall figures.)  Like reflect, this factor
ranges from 0-1.0, with 1.0 producing black shadows.  Use a small factor of .1 or less for softer
shadows.  Both wall and figure must have non-zero shade factors for shadows to be cast.  This also
depends on the location of the light sources.  Different locations for the light(s) may not produce
visible shadows on any particular wall (floor, ceiling, etc.)  This factor is ignored if the menu option
Shadows is not selected.

Rotate X -- the number of degrees the figure is rotated around the x-axis.
Rotate Y -- the number of degrees the figure is rotated around the y-axis.
Rotate Z-- the number of degrees the figure is rotated around the z-axis.
Note: the rotate variables have no effect on wall figure types.

Sizing -- vary width of figure based on sin or cos function.  This works on parametric figures (steps
set on auto).  The width of the figure is modulated with a trig function.

Sizing Factor -- determines the depth of the sizing function when applied to the figure.  Larger values
increase the minimum and maximum "peaks" that the sizing function produces in the figure.

Wrap Spacing  -- non-zero values in this variable produce a figure that "wraps" around the base
figure (see title picture for example.)  In order for the wrapping to line up, both wrap and base figure
must have the same Length, angles (rotational and omega/delta) and x/y/z offsets, etc.  The spacing
should be approximately the same as the base width, or slightly larger, to compensate for irregular
forms.  The width of the wrap can vary with the effect desired.  A good starting width is 1/5 the base
width.  The spiral distance for a wrap is determined by the spacing factor (see forms section), with
higher values producing closer spirals.
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Spatial Distance -- This works as a proximity factor, so that the auto steps option knows how close
it must come to the figure origin to complete one harmonic.  In the case of cyclical parametric
figures, such as lissajous, a figure can repeat the same route over and over, or a different route with
each harmonic.  The spatial distance factor tells Crocus to stop drawing the figure when it reaches
the proximity of the figure's origin. For Type 13, Fractal, this is the recursive Depth variable to
control the density of the fractal.  For Type 14, Kleinian set, this variable corresponds to the Epsilon
variable in Swirlique. 

xOffset -- the origin of the figure on the x-axis
yOffset -- the origin of the figure on the y-axis
zOffset -- the origin of the figure on the z-axis

Harmonics -- determines how many times a figure is drawn to the proximity factor (spatial distance.)
 If non-zero, the figure's route continues beyond the proximity factor n times.  Some figures, such as
lissajous, have more than one harmonic in their shape.  Crocus only draws the first harmonic when
this factor is zero.  Wraps may at times need additional harmonics to complete their route, since a
wrap is much closer spaced than the base form and is therefore harder (or impossible) to delimit
with just the spatial distance factor.  For Type 14, Kleinian set, this variable controls how often the
color changes for each segment.  Higher values produce more colors in the figure.  A value of 2
produces a two-tone figure based on color index 1 and 2.

Form
Each figure is composed of one or more forms.  The forms can be one of the built-in forms or a
Wavefront object imported into Crocus.  Major and minor sections apply to Sphere, Torus,
Cylinder and Teapot forms.  This affects the overall smoothness of the form.  The cylinder and
teapot forms use only the major sections variable to determine smoothness.  For Sphere, Torus and
Cylinder forms, 24 and 32 usually provide sufficient smoothness for small forms used for a "ropey"
figure, such as the lissajous type.  For a larger single form, you may want to increase major and
minor sections to produce smoother shadows.  Shadows use major and minor sections one fifth of
the entered values, to speed processing.  The teapot form requires a much smaller value for the
major sections variable, usually 10 or less being sufficient. 
Note: only the name and pathname of the Wavefront object is saved in Crocus data files, not the
object file itself.  If you decide to move the object file, Crocus may not be able to find it unless it
resides in a system path or the startup directory.

There are a few options that pertain only to Wavefront objects.  Select the Reverse-Wind box to
reverse the polygon winding for an object.  Some objects were created with their normals inside out,
which affects how light reflects on them.  Try reversing the winding if the object seems unusually
dark when displayed.  Select the Materials Default box to override the material file settings that
come with an object (if a mtl file is included with the obj file.)  This uses the material settings internal
to Crocus, and modified through the Defaults button.

Other edit boxes in this section include:

Width -- the forms width or radius.  Determines the overall size of the form used to make a figure. 
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Composite figures, such as the parametric types, are best drawn with small widths (approximately .1
or less).  Walls should have a width of 1 to fill the window's view.

Length -- the figure's unit length.  Determines the expansion factor for most figures, or how great an
area the figure will cover.

Spacing -- For non-wraps, a non-zero value forces the figure to be drawn with a minimum distance
between forms.  This overrides the pack variable and allows figures to be drawn where the forms
are evenly spaced along the route of the figure.  The distance between forms is approximately the
width of the form divided by the spacing factor.
For wraps, this factor determines the spiral distance, how close the spirals of the wrap are, and the
point which the wrap starts and ends its route.  You can vary the spacing in small amounts, so that
the wrap ends up at the same point it started.  Crocus attempts to keep a distance of at least one
form width between forms in a wrap, but gaps in the wrap may appear if the Spacing factor is set
too small (under 1.0).  For Type 14, Kleinian set, this variable controls the density of the figure. 
Higher values simplify the figure and allow the figure to be exported in a smaller object file.

Ratio -- The form's proportion height to width.  Used with the cone, sphere, torus and cylinder
forms.  In the cylinder's case, the cylinder width is increased or decreased in each segment, from
start to end.  The default is 1.0.  Use to stretch spheres and toruses.

Spin X -- rotate the form around the x-axis.  This affects the whole figure when the form is a
cylinder, else only the form is rotated.  Used to rotate one-step figures to see a different view, or in
the case of a sphere to see a different part of the texture mapping.
Spin Y -- rotate the form around the y-axis. This affects the whole figure when the form is a cylinder,
else only the form is rotated.  Used to rotate one-step figures to see a different view, or in the case
of a sphere to see a different part of the texture mapping.
Spin Z -- rotate the form around the z-axis. This affects the whole figure when the form is a cylinder,
else only the form is rotated.  Used to rotate one-step figures to see a different view, or in the case
of a sphere to see a different part of the texture mapping.

In addition to the Lsystems button (enabled when the Lsystem's type is selected), there are a couple
of variable boxes to edit with Lsystems.  The Max Lines variable controls how many lines will be
generated from an lsystems file (default 25000).  This number can be reduced for quicker
adjustments to scene elements.  Some lsystems, especially mutated lsystems (as produced in Fractal
Vision or Fractal ZPlot) may require this number to be increased to generate the entire figure.  The
Min Width variable controls how thin the lines are allowed to be generated.  Since Crocus allows
infinitely thin lines to be calculated, there are cases where line width in an lsystem might become too
narrow to be displayed on a computer screen.  So a non-zero number here limits the line width to a
viewable range.  Select the Extended box to allow Fractal Vision/Fractal Zplot syntax extensions to
be included in the calculations.

4.2.1 Edit Palette

    Palette command (Edit Figures)
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The palette editor is used to modify the palette for the current figure.  (Each figure in a figure list can
have a different palette.)  The palette is only used when a figure has no texture bitmap, or uses a
built-in texture such as Check; else white is used as the underlying color for textured figures.  Forms
use the palette sequentially (non-repeating over the complete form) as their major and minor sections
are drawn.  A figure based on a chain of forms, such as the lissajous type, or any figure with more
than one step, will repeat the palette in each of its individual forms or steps.  Note: some forms,
including cone, doctahedron and Wavefront object, use only color index 1 for their coloring.

There are copy and spread options to smooth or customize the palette.

Colors are shown in 8 groups of 29 colors, with four colors on the last row.  The palette is actually
60160 colors, with each succeeding color (except the last) followed by 255 colors that are evenly
spread from one color to the next.
  
Use the RGB-slider controls to edit any color in the palette.  Select Copy to copy any color to
another spot in the palette. Select Spread to define a smooth spread of colors from the current spot
to another spot in the palette.  Copy and Spread take effect immediately when you select another
spot with the mouse button.  You can cancel the operation with the Cancel button.  In the HSV
mode, color spreads are based on HSV values instead of RGB values, which in some cases results
in brighter color spreads.

Right-click on any point on the main window and the palette color for that pixel will be displayed in
the palette editor.

Use Reset to reset the colors of the palette in use, to where it was before it was modified.

 Use Reverse to reverse the order of the colors in the palette.  This affects only those colors in the
start-color to end-color range.  Useful for reversing divide-by-eight palettes, etc., for orbit-trap
pictures that require a reversed palette.

Use Neg to create a palette that is the complement of the current palette.

Use SRG to switch the red and green components of all palette colors.
Use SRB to switch the red and blue components of all palette colors.  SRB and SRG are disabled in
HSV mode.  You can use these buttons to form eight different palettes by repeatedly switching red,
green and blue components.

4.3 Texture

    Texture commands (Edit Menu)

A texture is modulated with the underlying color of the form to produce the final texture and color of
the form.  The texture can be one of the built-in textures, such as Check or Barber that are
modulated with the palette color or bitmap textures imported into Crocus.  There is also an option of
"None."  In this case, the figure's palette supplies the coloring for the figure.  The bitmap texture
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option is modulated with a neutral gray color, so the bitmap colors predominate.  Shininess is less
effective with bitmap texturing than using the built-in textures.  Generally you need a shiny bitmap to
produce shiny forms.  Use the "Bmp" command to import a Windows .bmp bitmap file.  

The mapping options determine how the texture is applied to an object.  Use spherical for objects
that use curved primitives like spheres and cylinders and linear mapping for cubes, etc. or when
spherical doesn't work as well.

Note: only the name and pathname of the texture bitmap is saved in Crocus data files, not
the bitmap file itself.  If you decide to move the bitmap file, Crocus may not be able to find
it unless it resides in the startup directory or the default textures directory (as appears in
the Preferences window -- default directories tab).

4.3.1 RGB

   Red, green and blue components.

4.3.2 texture

    Textures are normally bitmaps that wrap around or imprint a primitive form.

4.4 Lighting

    Lighting command (Edit Menu)

Use this command to adjust lighting parameters and position the light source(s).  Parameter boxes
are provided for controlling the RGB ambient intensity of figures and the entire scene (Model.)
Both sets of controls interact to produce light or heavy shading.  The ambient range is 0-1.0 for each
ambient control.  Higher values of ambiance produce bright figures with light shading.  Default values
are (.2,.2,.2) and (.6,.6,.6) for figure ambiance and model ambiance, respectively.  In two-lights
mode, another light is positioned at (-Light X, Light Y, Light Z).  This improves the scene's
illumination, and results in double shadows, if shadow mode is enabled and Light X is non-zero.

4.5 Preferences

    Preferences (Edit menu)

This allows you to view or edit the current default directories for saving and loading drawings,
objects, lsystems, videos and fractals.  Click on the … button next to each text box to choose a new
default directory.  Note: Crocus keeps track automatically of where you last loaded or saved a file
type, so it usually isn't necessary to change the current default directories.  Just save or load a file
from the directory you want to use as default and Crocus will set the default to that directory.

5 Image Menu

  Image menu commands
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The Image menu offers the following commands:

Draw Figure Draw the active figure.
Draw Scene Draw the active scene.
Auto Redraw Redraw image on command.
Auto Remote Open remote automatically at startup.
Full Screen   View image full-screen.
Pilot Use Pilot to rotate and alter key form variables.
Shadows   Draw shadows in scene.

5.1 Draw Figure command

   Draw Figure command (Image menu)

Use this command to draw or redraw the current figure.  Clicking inside the draw window with the
left-mouse button stops plotting on the figure being drawn.

5.2 Draw Scene command

   Draw Scene command (Image menu)

Use this command to draw or redraw the current scene.  Clicking inside the draw window with the
left-mouse button stops plotting on the scene being drawn.

5.3 Auto Redraw command

   Auto Redraw command (Image menu)

With this command disabled (on by default), redraw does not occur except when the Draw
command is executed.  Most of the time you want to see the results of changing a parameter or
mapping option, so redraw occurs automatically with parameter or mapping changes.  Sometimes
you want to change more than one parameter before redrawing the image.  So you need to turn this
option off then.  The state of this command is saved at program's close.

5.4 Auto Remote command

   Auto Remote command (Image menu)

With this command enabled (on by default), the remote is opened immediately at program startup. 
Handy if you find the remote useful and don't want to click on the toolbar button each time the
program starts up.

5.5 Full Screen

    Full Screen command(Image Menu)

Displays the entire plot, expanding or shrinking the image to fit in a maximized window without title
bar, scroll bars or menu bar.  At all other times, part of the picture is hidden by the inclusion of the
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title bar, toolbar, scroll bars and menu bar.  To exit full-screen mode, press any key or click the left-

mouse button.

5.6 Pilot

    Pilot

Use the Pilot window to rotate and alter key figure parameters interactively.  Use the speed control
to adjust the rate that the buttons change the figures position, etc.  The current figure can also be
adjusting using the keyboard:

Page Up -- decrement z angle of rotation(Rotate Z) by 5 degrees
Page Down -- increment z angle of rotation(Rotate Z) by 5 degrees
Home -- decrement x angle of rotation(Rotate X) by 5 degrees
End -- increment x angle of rotation(Rotate X) by 5 degrees
Insert -- decrement y angle of rotation(Rotate Y) by 5 degrees
Delete -- increment y angle of rotation(Rotate Y) by 5 degrees
up arrow --- rotate form 5 degrees around x axis(Spin X)
down arrow --- rotate form -5 degrees around x axis(Spin X)
left arrow -- rotate form 5 degrees around y axis(Spin Y)
right arrow -- rotate form -5 degrees around y axis(Spin Y)
y -- rotate form 5 degrees around z axis(Spin Z)
b -- rotate form -5 degrees around z axis(Spin Z)
l -- increment Width by width/10
s -- decrement Width by width/10
z -- increment Length by .1
x -- decrement Length by .1
i -- increment yOffset by .025
m -- decrement yOffset by .025
j -- decrement xOffset by .025
k -- increment xOffset by .025
u -- increment zOffset by .025
n -- decrement zOffset by .025

5.7 Shadows command

   Shadows command (Image menu)

Shadows are drawn for each non-planar figure.  With two light sources, double shadows may
appear, if Light X is non-zero.  With this mode enabled, figures cast shadows that appear on walls
(left/right, back, ceiling or floor), depending on the light(s) location.  Note: walls must have non-zero
shade values for the shadow to be calculated on it.  Figures must have non-zero shade values to cast
shadows.  The intensity of the shadow drawn is based on the sum of both a wall and figure's shade
values.  No attempt has been made to calculate shadow volumes that might be cast from one figure
to another. 
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Related topic: Edit/Figures.

6 View Menu

  View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar. 

6.1 Toolbar command

  Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most
common commands in Crocus, such as File Open.  A check mark appears next to the menu item
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

6.1.1 toolbar

  Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar
provides quick mouse access to many tools used in Crocus,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open the Remote which contains shortcut buttons for many common tasks and options
in Crocus

Opens or brings the Crocus Pilot to the front.

Open a new drawing window in Crocus.

Open an existing drawing.  Crocus displays the Open dialog box, in which you can
locate and open the desired file.

Save the active drawing or template with a new name.  Crocus displays the Save As
dialog box.

Set image size.

Draw figure from current parameters.

Draw scene from current parameters.



View Menu 25

© 2003 -- 2010 ... Mystic Fractal

Edit figure parameters.

Edit lighting variables.

Show picture full-screen.

Display info about Crocus.

Display Crocus's help index.

6.2 Status Bar Command

 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by
the selected menu item or depressed toolbar button, and keyboard latch state. A check mark
appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

6.2.1 status bar

 Status Bar

The status bar is displayed at the bottom of the Crocus window.  To display or hide the status bar,
use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus.  This area similarly shows messages that describe the actions of toolbar buttons as
you depress them, before releasing them.  If after viewing the description of the toolbar button
command you wish not to execute the command, then release the mouse button while the pointer is
off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.

7 Window Menu

  Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple images in
the application window:

Cascade   Arranges windows in an overlapped fashion.
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Tile     Arranges windows in non-overlapped tiles.
Arrange Icons     Arranges icons of closed windows.
Size Desktop     Size drawing area to window frame.
Window 1, 2, ... Goes to specified window.

7.1 Tile

Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

7.2 Arrange Icons

Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.  If
there is an open drawing window at the bottom of the main window, then some or all of the icons
may not be visible because they will be underneath this drawing window. 

7.3 Size DeskTop

Window Size DeskTop Command

Use this command to size the active drawing window to its frame size.  Use after Tile command to
reduce white space around a drawing that is smaller than screen size.

7.4 Cascade

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 

7.5 1,2, ...

1, 2, ... command (Window menu)

Crocus displays a list of currently open drawing windows at the bottom of the Window menu.  A
check mark appears in front of the drawing name of the active window.  Choose a drawing from this
list to make its window active.  

8 Video Menu

  Video menu commands
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The Video menu offers the following commands:

Open AVI Stream Open AVI file for writing and draw initial frame.
Write Frames  Write frames to AVI file.
Close AVI Stream  Close an existing AVI stream.
View AVI View an AVI animation file.

8.1 Open Avi Stream

    Open Avi Stream…

Through a series of windows, this allows you to name and open an avi animation stream, set the
frames per second (fps) and choose a compression method.  After using the file requester to name
the file, you are given a choice of compression methods.  The compression methods include Intel
Indeo Video®, Microsoft Video 1 and Cinepak Codec by Radius.  (All compression methods
degrade the original images, some more than others.)  The first key frame in the stream is then drawn
and written to the file.

Notes: after the stream is opened, the size of the fractal that can be drawn is fixed at the size of the
frame.  No changes can be made to the size until the stream is closed.

8.2 Write Frames

    Write Frames…

With this option, frames are written to a stream based on the difference between the current key
frame and the previous key frame.  The first key frame is written when you open a stream.  The next
key frame is created each time you use this option.  In between you can modify variables as much as
necessary.  The stream is only written to when this option is used.  The last key frame is
automatically saved after the 'tween' series is written.  The number of frames may range from 1-
1500 frames between keys.  With a frame number of 1 only the key frames are written.  This allows
animations to be created that incorporate all scaleable variables in Crocus.  Note: most figure lighting
data is automatically scaled for the number of frames.  Separate data lists are created when a video
is initialized and when the write-frame command is given.  So in order to animate a set of figures, you
only need to modify the data for each figure before using the write-frame command.

Use the Cancel button to exit this dialog without initializing a new series of frames.

Check the Log Scaling box if you want the frames to be written with logarithmic space between
frames, else linear space is used.
 
Notes: key frames are saved in parameter files (cs), with filenames of "bvf_image#_title.cs", where
'#' is the number of the keyframe and 'title' is the name of the working fractal file.  
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8.3 Close Avi Stream

    Close Avi Stream

Closes any open avi stream file.  You need to do this before viewing the file or creating a new avi
file.  The stream is also closed when you exit Crocus.

8.4 View Avi

    View Avi…

Opens an avi file for viewing.  You can preview any multimedia file by clicking on its file name.  A
multimedia box will appear to the right of the file list.  Click on okay to open the main view window.

There are buttons to Play a file forwards or Backwards, or forward automatically with Auto rewind/
repeat.  Click on Slow to slow down a video.  Each click on Slow halves the viewing speed.  A
click on Stop freezes viewing and restores the view speed to normal playback.

Use the Open button to view a different avi file.  Use the Save button to save the file in a different
compression format.  You must use a different name to save the file than the name that was used to
open it.  Click on the left-mouse button or any key to abort a save operation.

Note: the view avi requester can be used to preview any multimedia file, including midi files.

9 Help Menu

  Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Getting Started     Tutorial for new users of Crocus.
Index      Offers you an index to topics on which you can get help.
Hot Keys      Quick reference to Crocus's hot keys.
Figure Types     Mathematics for Crocus's figure types.
About Crocus     Displays the version number and author info for this application.

9.1 Getting Started

    Getting Started

Welcome to Crocus 4!
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This is a short tutorial that will cover basic commands and background material necessary
for a new user to create an initial picture with Crocus.  For help on any menu command,
press F1 while the command is highlighted. 
Figures compose the basic elements of pictures or "scenes" in Crocus.  Figures can be a
single primitive, such as a sphere, cube or torus, or a set of primitives in a complex
parametric type, such as a lissajous curve, or a lsystem or fractal file.  Actually, when you
reduce a parametric type to one step, you have a single object that is the primitive described
by its form.  There are also figure types for walls (vertical and horizontal planes), which are
useful for setting a backdrop to a scene.  Parameters for figures are defined in the Edit/
Figures window.  An entire scene is a list of figures.  Crocus allows you to define as large a
list as will fit in memory, then renders the list into a complete "scene" using the OpenGL 3D
library.  Extensions to the OpenGL library include routines for adding reflections and planar
shadows to the scene, for added realism.
The opening scene displayed when starting up or opening a new window will provide the
example for this tutorial.  If you open the Edit/Figures window, you'll see at the top three
drop-down boxes labeled Type, Steps and Figure.  The Figure box contains the list of
figures that the opening scene is drawn from.  Type designates the parametric equation or
fractal type each figure is drawn from.  Each figure (except the second) has its own texture
defined through the Edit/Texture menu. 
When you click on Apply, the screen is erased and the last figure that was edited is redrawn.
 Click on the close box of the edit window to exit the edit window without triggering a
redraw.  Use the left mouse button to abort drawing the current figure.  
The Pilot contains buttons to move, rotate and size a foreground figure.  This can be
accessed by the Spiderman icon in the toolbar or from the Image menu.  There are also
keyboard shortcuts for each button on the Pilot.

This completes the Getting Started tutorial.  Be sure to read the Edit/Figures, Hot Keys
 and Figure Types sections for additional info.

9.2 Index

Index command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can jump
to step-by-step instructions for using Crocus and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.
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9.3 Hot Keys

    Hot keys

(Parameters for current figure -- each key triggers a redraw)
Page Up -- decrement z angle of rotation(Rotate Z) by 5 degrees
Page Down -- increment z angle of rotation(Rotate Z) by 5 degrees
Home -- decrement x angle of rotation(Rotate X) by 5 degrees
End -- increment x angle of rotation(Rotate X) by 5 degrees
Insert -- decrement y angle of rotation(Rotate Y) by 5 degrees
Delete -- increment y angle of rotation(Rotate Y) by 5 degrees
up arrow --- rotate form 5 degrees around x axis(Spin X)
down arrow --- rotate form -5 degrees around x axis(Spin X)
left arrow -- rotate form 5 degrees around y axis(Spin Y)
right arrow -- rotate form -5 degrees around y axis(Spin Y)
y -- rotate form 5 degrees around z axis(Spin Z)
b -- rotate form -5 degrees around z axis(Spin Z)
a -- increment Form Shape
w -- increment Type
q -- decrement Type
l -- increment Width by width/10
s -- decrement Width by width/10
p -- increment Pack
o -- decrement Pack
z -- increment Length by .1
x -- decrement Length by .1
d -- increment Spiral Distance by .1
e -- decrement Spiral Distance by .1
i -- increment yOffset by .025
m -- decrement yOffset by .025
j -- decrement xOffset by .025
k -- increment xOffset by .025
u -- increment zOffset by .025
n -- decrement zOffset by .025
; -- decrement Omega angle by 5 degrees
' -- increment Omega angle by 5 degrees
, -- decrement Delta angle by 5 degrees
. -- increment Delta angle by 5 degrees
t -- toggle 'textured' flag

(Global)
f -- toggle 'use fog' option
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Ctrl-N -- new window
Ctrl-O -- open file
Ctrl-S -- save file
Ctrl-C -- copy bitmap to clipboard
Ctrl-V -- paste from clipboard
Ctrl-H -- Help index

9.4 Figure types

    Figure Types (mathematics)

0 -- lissajous -- x = Lsin(omega*t)cos(delta*t) y = Lsin(omega*t)sin
(delta*t)  z = Lcos(omega*t) t = step/360 L = length 

1 -- torus -- x = L(cos(45rt)-sin(45rt)) y = L(sin(45rt)+cos(45rt)) z = L t =
step/360 r = pi/180 L = length 

2 -- helical --  x = L/omega*cos(t)-L/delta*sin(t) y = L/omega*sin(t)+L/delta*sin
(t) z = L/delta+Lt/delta t = step/360 L = length 

3 -- spiral -- x = L/omega*cos(t)-L/delta*sin(t) z = L/delta+t/delta z = sin(t/10) x
= x*exp(.1t) y = y*exp(.1t) z = z*exp(.1t) width = width*exp(.1t) t = step/360 L = length 

4 -- corkscrew -- x = (L/omega-(L/omega*cos(t/10)))*cos(t)-L/delta*sin(t) y
= (L/omega-(L/omega*cos(t/10)))*sin(t)+L/delta*cos(t) z = sin(t/10) t = step/360 L = length 
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5 -- conal -- x = (L/omega+(L/omega*cos(t/10)))*cos(t)-L/delta*sin(t) y = (L/
omega-(L/omega*sin(t/10)))*sin(t)+L/delta*cos(t) z = sin(t/10) t = step/360 L = length 

6 -- tornado- x = (L/omega+(L/omega*sin(.1t)))*cos(t)-L/delta*sin(t) y = (L/
omega+(L/omega*sin(.1t)))*sin(t)+L/delta*cos(t) z = sin(.1t) t = step*r/5 r = pi/180 L = length 

when wrapping -- t = t/100

9.5 About Crocus

    About Crocus

>>>>> Crocus 4™ v1.014 ©1999-2010 by Terry W. Gintz

Crocus requires a true-color video adapter for best results.  It may work in 16-bit (high color), but
this hasn't been tested.

Crocus uses the OpenGL 3D graphics library from Silicon Graphics.

Acknowledgements:  The lissajous type in Crocus is based on the mathematical formula in Clifford
A. Pickover's Computers, Pattern, Chaos and Beauty, St. Martin's Press 1990.  Crocus's built-in
texture types were originally created by Linas Vepstas in 1994 to illustrate his OpenGL extrusion
library.  Wavefront is a trademark of Alias|Wavefront, a division of Silicon Graphics Limited.  The
Wavefront object loader in Crocus uses the GLM library written by Nate Robins.
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- B -
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button: |||||     7

button: >     7

button: abort     5
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button: draw     6
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button: help     6
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button: save     6
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button: V     8
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- C -
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- D -
definition: texture     21

- E -
edit: figure list     15

edit: lighting     21

edit: preferences     21
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edit: texture     20

exit     14

- F -
files: load jpeg     11

files: load parameters     11

files: load png     12
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files: save model     12

files: save parameters     11

files: write jpeg     11

files: write png     12

- H -
help: about crocus     32

help: figure types     31

help: hot keys     30

help: remote     4

help: tutorial     28

- I -
image: auto remote     22

image: draw     22

image: draw figure     22

image: mesh setup     13

image: pilot     5, 23

image: redraw     22

image: save figure dxf     14

image: save figure pov     13

image: save ls to obj     12
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image: show picture     22

- R -
rgb define     21

- S -
status bar     25

- T -
toolbar     24

- V -
video: close avi stream     28

video: open avi stream     27

video: view avi     28
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